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Changes to the Client Module

This section describes the changes that have bada ta theClients module.

Changes to displaying of drugs/products on the clin ical record

Go to: Clients menu >Animal Details > select animal :Record.

Previously, if you had selected to display Breigs tab on the Clinical Record, and you
bypassed thBrugs tab and entered stock items on the invoice, VisiPlMlisplayed all stock
items in the following areas of the Clinical Record

Drugs/Products Addedarea:

Drugz/Products Added |

1 of Waccination Diog
B0 of Rirnadyl T ablets [100]

=l
Drugs tab:
I el
[ty | I | Drug | Instructions
1 W “accination Dog
G0 ¥ Rimadyl Tablets [100] 1 tab per day as directed.

The above functionality did not suit all clientsetefore, a change has been made in VisionVPM.

Now, if you bypass thBrugs tabs, only stock items with a drug label entere@omvoice will
be displayed on the Clinical Record.

All stock items entered through tBeugs tab will be displayed on the Clinical Record ashe
previous version.

If you have selected to not display fBaugs tab, all stock items will be displayed on the Giadi
Record, as in the previous version.
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Ability to search by Animal Seq Number

Go to:Clients menu >Animal Details.

You now have the ability search for animals byrtisequence number. Animal Seq No.
option has been added to thearch Bylist, as shown below:

Search By |Name j |Eontaining j

Animal N E:mz.ﬂ:‘et M ame £ I LIzt

2004 Colt [R5 COMTRA

2004 Cal CONTRAZ

2004 Filly CONTRAZ

2004 Filly i frreer-Eoe COMTRAT

5ol Tre Breed Desc TE T&H Black

93[Trade {Pet Mame TE T&H Chestr,

99e/Shes 'E;f':nf'“'m CARRAM  Chest

99 /Raps] Sire CARRAM Black.
Custam 1

2 Custam 2 RRAM 2343

&by Eﬂiiﬂmi MARTYM  Tri- Cah

Acceptabl tliant Code FCARRAMN Bay
Client Laztname

2ir Head |Client Comparny DFEDR black.

Alpac  Client Address DAMSO  Equine

You can use this number, for example, for radiology

Additional Merge fields for Vacc Adhocs

To edit vaccination reminder adhocs, goRite menu >Adhoc Reports> Reports> Open>
select adhoc.

To run vaccination reminder adhocs, goN@in menu >Client module >Client menu >
Reminder Schedule> make selections Run > Adhoc.

The Vacc Reminder Adhocs now have the followingays:

You can now include the Reminder Text in adhocs.
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Reminder Details - C5

X

il Cancel F2

Code | C5 = Monthly ¢ Daily

Desc | 5, Parvo, K.ennel Cough, Hepatitis

[ Daon't dizplay these reminders on the client details zcreen.

Text

The Ch vaccination proves protection against distermper, hepatitiz, parvo virus and J

parainfluenza. If you have any concerning about the post-vaccination behaviour of your
dog pleasze contact the clinic.

Field List |

This field is called [F_Vet Remind.REM_BODY].

Patient Name
Honey

Vaccination / Reminder

Date Given Date Due Status
C5 _Parvo, Kennel Cough Hepatitis 20 MAR 09 20 MAR 10 Due in 5 days

The C3 vaccination provides profection against distemptler, hepatitis, parvo virus and parainfluenza. If you have any concerning about the
post-vacciantion behaviour of your dog please contact the clinic.

All patient adhocs have the option of adding tieddffANIMALPHOTQ] to display the

animal's photo. Please note that the size of tléoptannot be changed from the thumb nail
size (max of 2.5 cm for length and height).



Changes to the Supplier Module

This section describes the changes that have bada ta theSuppliers module.

Ability to select an edited line position

Go to:
Suppliersmenu >Supplier Invoice > select invoice Edit
OR
Suppliersmenu >Goods Receipts> selected goods receipEslit.

Currently, when you edit a line in either a suppiivoice or a goods receipt, VisionVPM will
drop the line back to its original position in tingoice.

A change has been made to allow you to specify drghe edited line drops to the bottom of
the invoice or back to the place it was originally.

To be able to drop the line to the bottom of theioe you must select one of the following
options by going toMain menu >Maintenance module >Maintenance menu >System
Defaults > Financial tab >Supplier Financial area.

Supplier Financial

Edited linez drop to the bottorm of the lizk on theze supplier windows:
" Mone  Good:s Receipt & Invoice & GR and |nvoice

On applying this update, the default will be selNtme. That is, VisionVPM will drop the edited
line back to its original position.
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Changes to the Payroll Module

This section describes the changes that have bada ta thd?ayroll module.

Multiplier of 1.5 for Relevant Daily pay

Go to:Main menu >Payroll module >Payroll menu >Allowances and Deductions

A multiplier field has been added to the popup wind displayed wheRrompt for Relevant
Pay or Prompt for Average Earnings are selected.

This allows a multiplier to be used on allowanaeshsas Public Holidays. This multiplier will
come through from thAllowance itself. The selected pay rate will be multipliedthg
multiplier.

The multiplier cannot be zero.

The multiplier is entered in th&llowances/Deductionsvindow:

Allowance/Deductions - PUB HOL Al=l.3

X

Cancel F8

Code | PUBE HOL

Mame | Public Holiday

GL Account Code | 330 -

Fultiplier | 1.5 W Include in Holiday Gross

* % &+ Taxable Allowance
" Tawable Deduction

" Rate 1 " Mon Taxable Allowance

"~ Fiate 2 " Mon Taxable Deduction
" Holiday Pay [T axable]

i Rate 3 ™ Sick Pay [Tazable]

 Rate 4 i Bfaree!ver!'uent Pay [Taxable]
" Time in Lieu Accrued

" Ratef " Time in Lieu Taken

[ Ireqular ar discretionany payrnent

[V Prompt for Belevant Pay [zick, bereavement, public holiday, alternative haliday) I

[ Prompt for &verage Earnings [normal halidays) I

When loading the pay run, goktain menu >Payroll module >Payroll menu >Pay Run>
select employee > edit transactions.

When the appropriate allowance, for example, Piidiiday, is selected and tiigty is entered
a pop up window will be displayed.
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WhenPrompt for Relevant Payhas been selected, the following window, now \&itmultiplier
field, will be displayed:

Sick/Bereavement/Public Holiday Pay Calc

il
& Relevant Daily Pay [12 FEB 10 to 12 MAR 10]

Grogs Earnings for period: | 360.00

Oty (howg], | 30.00 Days worked: |0
Felevant hourly rate: |12 Felevant daily pay: | 0.00

Baze the pay rate on:

¢ Helevant hourly rate of 312 00
[Uze thiz rate for an employes with reqular hours when paving sick, bereavement or public holidays]

~
[Uze thiz rate for an employes working iregular hours when paying zick, bereavement and public holidayz]

~ Agieedrate |0

[Uze thiz rate when the amount has been agreed with the employes]

@DWEHCE kultiplier: | 1.50 ) Continue

TheAllowance Multiplier value of 1.5 has been brought through from thdi€tioliday
allowance example.

OR

WhenPrompt for Average Earnings has been selected in tAlowance window, the following
prompt, now with a multiplier field, will be disptad:

Holiday Pay Calculation

Ordinary Earmingz [13 FEB 10 to 12 MAR 10]
Earningz: $360.00 Oty 30.00 Rate: $12.00

Average Earnings [13 MAR 09 to 12 MAR 10]
Earningz: $360.00 Oty 30.00 Rate: $12.00

Base the Holhday pay on:

 Agreed holiday rate of | 0
Gllnwance Multiplier: | 1.00 ) Continue

TheAllowance Multiplier value of 1.00 has been brought through from addgiiPay
Allowance.
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Changes to the Maintenance Module

This section describes the changes that have bada to théVlaintenancemodule.

Ability to select an edited line position

Go to:Main menu >Maintenance module >Maintenance menu >System Defaults>
Financial tab >Supplier Financial area.

New options have been added to VisionVPM to all@u §o specify whether an edited line drops
to the bottom of a supplier invoice and goods goai back to the place it was originally.

Currently, when you edit a line in either a suppivoice or a goods receipt, VisionVPM will
drop the line back to its original position in tingoice.

To be able to drop the line to the bottom of theioe you must select either:

Goods Receipt will only apply to goods receipts.

Invoice - will only apply to supplier invoices.

GR and Invoice - will apply to both goods receipts and suppliemices.
Supplier Financial

Edited linez drop to the bottam of the lizt on theze supplier windows:
" Mone  Goods Receipt & Invoice & GR and Invoice

On applying this update, the default will be selNtme. That is, VisionVPM will drop the edited
line back to its original position.

Changes to Autobanking

Go to:Maintenancemenu >Codes and Descriptions> Auto Banking Setup.

The following changes have been made to the BahkpSeindow. Please note, these changes
only affect New Zealand databases.

The TSB bank format has been updated to meet thugreenents of the TSB bank.

Dashes have been included in Waur Bank Account Number field to indicate the required
account number format. For example, TSB requirebtirk account number to be in the
following format: 6 - 7 - 3.
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Bank Setup - Provet IT Ltd

J| X

Save F7 | Cancel F2| Delete/D

¥ | wart bo use autabanking for my supplisr paymerts.
[+ | wart ko use autabanking for my payrall,

I1ze the farmat for:

~ Mational Bank ¢~ ASE [MT9 Farmat) i+ TSH

i ANZ  Westpac Trust

i BMZ i Countrwide

[ Disk Transfer

“'our Company Mame Bank Account Code

| Provet IT Ltd | 4001

Default Dutput file name [include directary path) “'our Bark Account Mumber

| o hwigiorwpmibankinghautobank. aba

Example file name: C:A\0mnis 7B anking\Autabank:. txt
FPaproll Qutput file name (include directory path)
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Resolved Issues

The following issues have been resolved in thigdbui

General

SQL Locks not clearing

VisionVPM, previously, was not clearing all SQL kscwhich caused issues when multiple users
attempted to access the same records.

Extra checks have now been put in place so wheilonW#*M starts up, all SQL locks for a
user's serial number will be removed as well asramaining locks for the previous day and
beyond.

Inability to log into VisionVPM
Go to:File menu >User Logon

Previously, somé&Jser codes andPasswordswere not recognised by VisionVPM and therefore
you were unable to log into VisionVPM. This was daeencryption problems witbiser codes
andPasswords

This issue has been corrected in this version.

Discount amount incorrect for formulation Stock Pri cing window
Go to:Main menu >Stock Pricing > enter formulation.

Previously, VisionVPM displayed the incorrect disnbamount on the Stock Pricing window
when you had selected a stock item marked as aufation.
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W stock Pricing

’ Ruick Stock Pricing
: StocksS | Activitedy' | Dept /P | Cloze F3
Standard Digcount
Code & Desc IEL&\-’BDTEDD _v_" Clavulox 100mg Full Bottle _vJ 1 = fucefcl_fon D 1tu:19 £
Cluanitity | 10.0000 Clignt M arker I 2 RN i 49
Price [inc] | 3475.00 Frice [E:-:c:]I 3088.89 3'I A 124325 I o0
Disc Price [in.:I 3475.00 | Disc Price [E:-cc]i 028,89 Special Date Dizcount
Or hand | [ % From| Ta|
Multiple Sale Pricing
Pref. Supplier r_ Perc % Price [inc) M arker
Motes _A! I-I I I
2] I I
3 I |
2.| I I
il | |
Loypalty Scheme
Thiesheld 000 Free 000 Marker|

Now, the correct price is displayed, as shown below

W stock Pricing

’ Ruick Stock Pricing
= StockdS | Activitpsy' | Dept/P | Cloze F3
Standard Digcount
Dizc % Price [Inc] from Oty ko Oty
Code & Dese |CLAVEBOTEO00 - |{Clavulox 100mg Full Battle  ~| {77 T3z |10 13
Cuiantity | 10.0000 Cligrt # ark.er I ; ; 49
Frice [inc] I 475,00 Frice [E:-:c:]I 3088.89 3'I A 124325 I o0
Disc Price [inu:]lI 312750 |Disc Price [Exc) | 2760.00 Special Date Discount
Or hand | [ % From| Ta|
Multiple Sale Pricing
Pref. Supplier r_ Perc % Price [inc) M arker
Motes _A! 1. I I
2] I I
3 I |
2.| I I
= el | I
Thiesheld 000 Free 000 Marker|
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Contact Method removed
Go to: Quick Accessmenu >VPM Navigator > select a reminder option.

Previously, VisionVPM removed theontact Method from clients when you had selected
reminders from the Navigator pane.

| Animal M ame | [Jzer | Date Given| Date Due | E!l_l,l| Matified | Statuz | EnntactMethad|
Bear : 24U 10 1 20AUG 08 J
Buster DF 4JuW1o 10
Buster DF 4JuW1o 10

This has been corrected in this version and nowoWisPM correctly displays client€ontact
Method.

| Animal M ame | [Jzer | Date Given| Date Due | [ty | Matified | Statusg Contact bMethod
Bear : 2JUW 10 1 204G 03 Email J
Buster DF 4JuN1o 10 Tt
Buster DF 4JuN1o 10 Tt

Clients Module

Multiple invoices not transferring correctly
Go to:Clients menu >Client Details > select client *Activity > select invoices ¥ransfer.

In the previous version, VisionVPM only transfertée first invoice in the following
circumstances:

You had selected multiple invoices.

You were transferring the invoices to a client nearlas a Syndicate.
Now, VisionVPM correctly transfers all selecteddimes.
Adhoc fields printing in stock letter
Go to:Clients menu >Animal Details > select animal #voice.

Previously, VisionVPM did not calculate all adhaelds names in a stock letter when you had
selected to use an adhoc file as a stock lettehdmexample below, the patienkge, Last
Vaccination Dateand thevVets Namehave not printed.
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Patient:
Mame: Honey

Sex Female Meutered
Details:  Gold
Age:

Microchip: 3989284922

This is to certify that Honey has been sterilised by this clinic

LastVax Date:| |

Vets Name: | |
YWet Clinic: Provet IT Veterinary Clinic Lid

Now, VisionVPM will display all adhoc fields corritg in a stock letter, as shown below:

Patient:
Mame: Honey
Sex Female MNeutered

Details: )
Age: 4 months and 3 weeks old

Microchip: 3989284922

This is to certify that Honey has been sterilised by this clinic

LastVax Date: |13 MAY 10
Yets Mame| Harry Abkot

YWet Clinic: Provet IT Veterinary Clinic Lid

VisionVPM not displaying up to date reminder inform ation

Go to:Clients menu >Animal Details > select animal :Record > enter details 3nvoice >
Save> Animal > Reports.

In the previous version, VisionVPM did not displa@minders created today on reports printed
from theReportstab of the Animal Details window.

Now, VisionVPM correctly displays all reminders mports.

00



VisionVPM not scrolling through Clinical Descriptio n templates
Go to:Clients menu >Animal Details > select animal Record> Desc. List> select template.

Previously, when you had selected a template aantaresult fields () and the template was
longer than the screen, when you tabbed through efabe result fields, VisionVPM did not
move the template up, therefore, you could notlse@emainder of the wording.

Ciinical | &nimal | | Desc. ListiL |

Problem ( ) .

Client concern ()
Resp (JBCS(JCR{}DG(ICR{}PS (]
Murze findings (

Vet Exam

Hizgtory [ }

Exam { ) —
T{JHR{ YRR}

1. General appearance () 2Evez () 3. Earz ()

4, Mucus membranss (j  5.5kin () &. Circulatory ()

7. Respiratory () 2. Digestive () 9. Genitourinary ()

10.Mugculoskelatal (v 11.Lymph nedes ()

12 Neuro system ) | j

Now, VisionVPM will move the template up so you kahe ability to view the rest of the
template.

Clinical | Animal | | Dese. ListiL |

Exam [ } ﬂ
T{JHR{}RR(}

1. General appearance ( ) 2.Eves () 2. Earz(}

4. Mucus membranes (}  5.5kin () §. Circulatory ()

7. Respiratory () 2. Digestive () 9. Genitourinary ()

10 Musculpskelatgl v 11.Lymph nodez ()

12 Neuro system ()

(Lzzeszment -[:

Plan (}
Further diagneostics ()

Treatment ()

Clignt Cemmunication ()

Esch ?c_k () j

Please note, if there is a line on the edge oihdow, VisionVPM will not move the template
up, however, when you start typing in a resultfiglthe template will be moved up and you will
be able to see what you are entering.
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Duplicate animal names on list when batch invoicing

Go to :Clients menu >Batch Invoice > Insert > Animal Code > enter a letter ETRL+Q >
scroll down list using mouse wheel.

Previously, when the number of animals displayezbeged one screen, the animal names
showed duplicates with the same code. Clickingrondad the lines would make that line
redisplay the correct animal.

Now, VisionVPM will display the list of animals wibut duplicates.

Current and Total amounts displayed incorrectly in Batch Receipting
Go to:Clients menu >Batch Receipting> enter dates ¥esto displayed client's aged balances.

Previously, VisionVPM incorrectly displayed tRirrent andTotal amounts on the Batch
Receipting window. This occurred when you had getkto display the Aged Balances for
clients.

Please note, théurrent Bal. Due field has been renamedBalance Due
TheBalance Dueis the total amount a client owes.

In the example below, the client has a total ontfiteg balance today of $224.00, with $129.20
due in the month of March.

Screen shot in previous version:

Current Bal. Due: 224.00

Aged to 31 MAR 10
Total 224.00
Current 224.00

1 Mth Q.00

2 Mth Q.00

3 Mth Q.00
Delayed 0.00

Now, VisionVPM correctly displays the client's adgegalances, as shown below:

Balance Due; 224.00

Aged to 31 MAR 10
Tatal 129.20
Current 129.20

1 Mth Q.00

2 Mth Q.00

3 Mth Q.00
Delayed Q.00
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Animal name not displayed on invoice/statement
Go to:Clients module >Reports menu >Invoice/Statement Run

Previously, VisionVPM did not display the total anmb for an animal's invoices on an
invoice/statement report. This only occurred inftiiwing circumstances:

You had transferred an invoice to a client marked &yndicate.

You printed an invoice/statement report for on¢hef Syndicate members.

Tax Invoice/Statement
Sally Charters

274 Western Lane

_ Page: 1
Dunedin
TAURAMGA Date: 31 MAY 10
CLIENT CODE: CHART2T
Date Vet | Qty | Description Price Payment Balance
Balance Forward -27258.38
10 MA&Y 10| LA I No. 42073 Honey
.1 | Bitch Spey Basic Fee 4528
Total for Invoice 4828 27213.10
M MAY 10| LA Inv No. 42161 Honey 10.00% Share
A Conzultancy Fee 540
A (|Walker 1.30
Total for Invoice 570 27205.40
Ty Ho
13 MAY 10| LA Inv No. 42091 Victory Saint Stud 10.00% Share
A Conzultancy Fee g.
Total for Invoice 5.00 -2TZ200.40
Total for Ty Ho $5.00 (Includes GST of 30.67)
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This issue has been corrected in this version@ow, VisionVPM correctly displays the total
amount for an animal's invoices on an invoice/st&iat report.

Sally Charters
274 Western Lane

Tax Invoice/Statement

- Pags: 1
Dunedin
TAURANGA Date; 31 MAY 10
CLIENT CODE: CHART27
Date Vet | Qty | Description Price Payment Balance
Balance Forward -2T258.28
10 MAY 10| LA Inv No. 42073 Honey
.1 | Bitch Spey Bazic Fee 4523
Total for Invoice 45.26 -2T21210
Honey
3 MAY 10| LA Inv No. 42160 10.00% Share
1 ||Conzsultancy Fes 5.40
A ||Walker 1.30
Total for Invoice §.70 27208.40
Total for Honey 28.70 (Includes GST of 30.74)
Ty Ho
13 MAY 10| LA Inv No, 42091 Victory Saint Stud 10.00% Share
.1 | Conzultancy Fee g.
Total for Invoice ] -27200.40
Total for Ty He 55.00 (Includes GST of $0.57)

Overdue amount incorrect invoice reversal

Go to:Clients module >Reports menu >Check Expired Discounts

In the previous version, VisionVPM included delayddrge invoices in th@verdue amount,

which was incorrect. Th@verdue amount should not contain delayed charge invoicdis the
month they are due.
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Prompt Discount List

Murnber | Iree. Total | Dizcount | Bal Due | Payrnent | Owverdue | Reverze
SMITH22 37803 -1.80 1.60 -956.60 0.00 -95E.E0 j
SMITHFD1 38362 020 0.0z 12593.38 0.00 1239.38 ®
SMITHFD1 38363 1.70 019 12593.33 0.00 1239.38 *
SHITH4 38365 1.70 019 95.90 0.00 55.90 * Update
SHITH4 28369 .90 0.7E 93.90 0.00 99,90 # J
SHITH4 28367 .90 076 93.90 0.00 99,90 # Erirtt List
SMITH4 28366 3.40 0.3s 93.90 0.00 99,90 #
RN 295493 30.80 1.62 154.50 0.00 154.50 *
R&WSO2B 42194 2810 2810 5947.80 0.00 .
RADCLYET 37215 -5.00 4.44 E73.24 .00 324 #
OMET2 a7 -6.00 533 87.50 0.00 g7.50 #
MAIRMNIOT 37813 -2.30 2.04 8552.09 0.00 2332.09 #
MARTY49 40011 72.00 775 228.40 0.00 228.40 *
LAWRETZ21 38988 -2680.00 2977.EBE -1987.82 noo 198782
LAWRETZ21 38388 -2680.00 29777 -1987.82 oo 198782
LAWRETZ21 38388 1340.00 142,85 -1387.82 oo 198782 #
LaWwWRETZ21 38388 26E0.00 29777 -1987.82 oo 198782 #
KINGS121 42183 -6.70 .70 153.30 0.00 153,30 #
FINGS121 37812 -251.70 22373 153.30 0.00 153.30 #
KIMBE121 40917 15.10 1.68 10377.62 000 1037762 #

FIMEE121 42192 -1.50 1.50 1037762 0.00 1037762 ﬂ Cancel

[V Create one entry per client for the discount reversals

Mote: A " in the reverse column indicates that thiz dizcount given will be reversed.
Y'ou can manually change thiz by clicking on it and adding or deleting the *=*.

] Balance Due | 5,847 20 [3859.8] delayed,

In the above example, delayed charges for thistcliemount to $3859.80, therefore, only
$1988.00 should be displayed in tBgerdue column.
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This issue has been corrected, and nowerdue amount is displayed correctly, as shown
below:

Prompt Discount List

Murnber | Iny. Total | Digcount | Bal Due | Payprnent | Owverdue | Reverze

SMITH22 37803 -1.80 1.60 -956.60 0.00 -95E.60 ﬂ
SMITHFD1 38362 n.z20 0.0z 12593.38 0.00 1299.38 #
SMITHFD1 38363 1.70 0149 1299.33 0.00 1299.38 #
SHITH4 28365 1.70 019 93,90 0.00 99,90 # Update
SHITH4 28369 £.90 0.7 93.90 0.00 §5.90 # J
SHITH4 28367 .90 076 93.90 0.00 99,90 # Errint: Ligt
SMITH4 28366 3.40 033 93.90 0.00 99.90 *
RN 39593 3080 1.62 154.50 0.00 154.50 #
RAWSOZE 42194 2810 28.10 1938.00 0.00 x
RADCLYET 37215 -5.00 4.44 E73.24 0.00 B73.24 #
OMET2 a7 -6.00 h.33 87.50 0.00 B7.50 #
MAIRMIO01T 37813 -2.30 204 8552.09 0.00 8992.09 #
MARTY49 40011 7200 7.75 228.40 0.00 22840 #
LAWRETZ21 38388 -2680.00 2977.6R -1387.82 oo 198782
LAWRETZ21 38388 -2680.00 29777 -1387.82 oo 198782
LawWRETZ21 38388 1340.00 148.89 -1987.82 noo 198782 i
LAWRETZ21 38988 2620.00 297 .77 -1987.82 noo 198782 #
KINGS121 42153 -6.70 E.70 153,30 0.00 153.30 #
KINGS121 37812 -251.70 22373 153.30 0.00 153.30 #
KIMBET21 40917 1510 1.68 9025.32 0.00 q025.32 #
FIMBE121 42152 -1.80 1.50 9025.32 0.00 025,32 # ﬂ Cancel
[V Create one entry per client for the dizcount reversals
Mote: A ™" in the reverse column indicatez that thiz discount given will be reversed.

rou can manually change this by clicking on it and adding or deleting the "=

Incorrect option prompt when exporting client balan ces
Go to:Clients module >Reports menu >Export Balances> Print.

Previously, VisionVPM prompted you to export thie fivthen you had selected to print the
report.

This issue has been resolved in this version.

General Ledger Module

Account Activity report displaying opening balance as zero for Profit and Loss
Accounts

Go to:General Ledgermodule >Reports menu >Account Activity.

In the previous version, VisionVPM displayed theenjmg balances of Profit and Loss accounts

on theAccount Activity Report as zero. The opening balance should have beelaykspas

the closing balance for the previous period softti@account activity equals the amounts on the

Balance Sheet

The opening balance for Profit and Loss accoumsvs calculated from the current financial
year entered in thBate Selectionwindow.
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Date Selection

From Date | 14PR 09
To Date | 31/3/10

[T Select Account Code(s) Ok
[~ E=port to a tab-delimited file
[~ SendtoExcel

Cancel

Balance sheet accounts are still calculated frany#dar Beginsdate displayed i€ompany
Information .

Incorrect general ledger account type displayed
Go to:General Ledgermodule >Reports menu >Monthly Profit and Loss.

Previously, VisionVPM displayed the incorrect gerléedger account type on the Monthly
Profit and Loss report, in the following circumstas:

You had selected tHese subtotal header accountsheck box.
You had selected theend to Excelcheck box.

The accounts with the incorrect account type haddaiivity or balance but needed to be
added to the list as they had other accounts sllotto them.

5400 Hospital & Mursing Fee Income | Sales
6300 Lab/Diagnostic - Cost Of Sales
5300|Lab/Diagnostic Income Sales

This issue has been corrected, and now VisionVRdlays the correct account type, as shown
below:

201 Cost of Sales Furchase
6300 Lab/Diagnostic - Cost Of Sales
165 Recovery Of Bad Debts Income

Supplier Module

Supplier invoice loses supplier details when editin g a stock item

Go to:Suppliers module >Suppliers menu >Supplier Invoice > Insert > enter supplier
invoice header details.

VisionVPM incorrectly removed the supplier invoiceader details when you took the following
steps:

From the Supplier Invoice window, enter a stocknite
Partially enter another stock code or descriptaong click theCode or Description arrow.

Highlight the required stock item, and cliEklit.
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From the Stock Details window, cligkctivity .
Click Closeon the Activity window.
Click Closeon the Stock Details window,

From the Stock List window, select the requirectkttem.

Suppher Invoice - New

i Ll ! 9. L .
& % || P K ®
Save F¥ Eanc:el Fa st FD I .&ctivif}u"‘(’ Frint/F | Barcode/B | StocksS | Ferce Cloze F3

Supplier | _'“ Department | 0 i 1 Clear Line
Invoice Nu.i User Code | 2 ] Clear &l
Date ]
Stock Code GL Afz Drezcription Frice FPackzize Dept [ty Tokal
12629 = |[1037 _=|[Revoltion Cat 7 5kg Blue (5] =l | | |
30703 430 Advance Fel Adult Fish 400g (IN HOL 2358 24 1 2958 _J
10193 430 Reverzine 5 4 Inj 307E 20 1 078
12934 430 Revolution Cat 7.5kg Blue (3] .38 1 1 .38

Now, VisionVPM keeps all supplier invoice headetails when editing a stock item.

VisionVPM removed the supplier invoice date
Go to:Suppliers menu >Supplier Invoice > Insert.

Previously, VisionVPM removed the invoice date wiyen took the following steps:

You had not selected to use the Delayed Chargdifumio VisionVPM.
You entered a stock code and clicked $iteck Codearrow.

You double-clicked the required stock item.
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Supplier Invoice - New

X

Save F7 | Cancel FB| (e in | o He /5| Cloze F9

Supplier  Supplier [PROVETT = |[Frovet Depariment([3 = Clear Line
Invoice e No. W User Code m Clear All
|Date J |
Stock Code GL Afc Dezcription Frice Packsize Dept Ot Total
[seat =l =l =l -
Z
System I Mett | oog  GST | 0.00 Tatal | 0.00

Now, VisionVPM correctly retains the invoice date.

Supplier Invoice - New

S| X | & %)

Save F7 | Cancel FB| (e in | o ActivitusY Fecaipta/E | Close F9

Supplier  Supplier [PROVETT = |[Frovet Depariment([3 = Clear Line
invaice Inice Mo, | 159231 User Code ]BE T LClear Al
| Date [1JUN 10 |
Stock Code GL Afc Dezcription Frice Packsize Dept Ot Total
[sent | =l =l I
7
System I Mett | oog  GST | 0.00 Tatal | 0.00
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Stock Code not displayed

Go to:

Suppliersmenu >Supplier Invoice > Insert.
OR
Suppliersmenu >Provet Options > Open Pending Invoice List> select an invoice.

VisionVPM did not display th&tock Codein a supplier invoice when you took the following
steps:

You either double-clicked an existing stock iterrelior tabbed through to tiescription
field.

Clicked theDescription arrow.

Located and double-clicked the required stock item.
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Now, when you find a stock item via tBescription arrow, VisionVPM will correctly display
the Stock Code

Ability to save a pending invoice with no date
Go to:Suppliers menu >Provet Options> Open Pending Invoice List

In the previous version, VisionVPM allowed you tove a pending invoice with no date in the
following circumstances:

You had changed suppliers and,

the selected supplier was not the nominated Psaygtlier.

Now, when you attempt to save a pending invoicéabove circumstances, VisionVPM will
display the following message:

You will need to clickOK and then enter the invoice date.



Supplier opening balances missing on statements

Go to:

Suppliers module >Reports menu >Print statements> enter date ©Kk.
OR

Suppliers module >Suppliers menu >Supplier Details > select supplier Statement>
enter date k.

In the previous version, VisionVPM did not displing Supplier's Balance Forward amount on
the Supplier statement.

Now, VisionVPM correctly displays the Balance Fordramount, as shown below:
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Stock Module

Negative values in formulations not updating

Go to: Stockmodule >Stockmenu >Stock Details> select stock iterm Edit price details >
Save

When you clicked Yes to the message below, prelyolMssionVPM only updated formulation
components that had a value greater than zero.

If a component of a formulation had a zero or tiggaotal, VisionVPM would not update that
component in the formulation.

VisionVPM will now update both positive and negatiormulation components. Zero value
components (like formulation headers) will not Ipelated.

When VisionVPM updates formulations it will updake price to the current sales price * gty
sold + dispense fee.

Duplicated stock items in Formulation window
Go to: Stock module >Stock menu >Stock Details> select formulation Formula.

VisionVPM, previously, displayed duplicate stooénts in the Formulation window. This
occurred when you took the following steps:

In the Stock Formulation window, double-click a qmment stock item.
Press ENTER to drop the stock item down again.
Click the Code or Description arrow.

Click Closeon the Stock List window.
The previous stock item that you edited is poséthm the editing line.

Press ENTER to drop the line down.

This issue has been corrected in this version.
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Reorder Qty rounding part packs to zero
Go to:Stockmodule >Stock menu >Stock Ordering > Stock Reorder.

Previously, when thRound part-packs to a whole paclkcheck box was selected in tG&ck
Reorder Options window, VisionVPM rounded anything less than tejack to zero.

Now, where a quantity to be ordered is less thpack size, and thRound part-packs to a
whole packcheck box is selected , VisionVPM will round theaqtity to be order to 1 pack size.

Boarding Scheduler

Boarding Schedule overlapping
Go to:Main menu >Boarding Schedulet

Previously, VisionVPM overwrote boarding schedypp@ntments when a selected suite was
unavailable for the specified period of time.

Now, VisionVPM will correctly allocate available ises.

Ability to select incorrect suite number
Go to:Main menu >Boarding Scheduler
VisionVPM was incorrectly creating another boardsugte in the following circumstances:

Edit an existing booking of a suite number thatsdoet exist for another suite name.

Change the suite name without changing the suitgbeu.



For example, if you had 3 Dog suites and 2 Caeswnd a booking had been entered in Dog
suite 3, when you edited the booking and changedufte name to Cat suite and saved,
VisionVPM was creating a 3rd Cat suite.

Now, when you process the above steps, VisionVPMdigplay the following message:

You must then cliclOK and select a valid suite number to continue.
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